
 
 

Carlson Software | 33 East Second Street | Maysville, Kentucky USA | 606.564.5028 
www.carlsonsw.com 

 

 

 

 

 

 

 

 

Carlson Point Cloud 
Quick Start Guide 

 



 
 

Carlson Software | 33 East Second Street | Maysville, Kentucky USA | 606.564.5028 
www.carlsonsw.com 

Lesson Objectives 
In this class, we will be discussing basic procedures to obtain a representative surface model (TIN) of a 
project site from a point cloud resulting from LiDAR or areal photogrammetry. In addition, common 
steps to obtain survey data from the point cloud, i.e., virtual surveying, will also be presented. It is 
important to understand that the lessons through this class are not intended to be fully comprehensive 
as all point cloud projects pose their own unique set of challenges.  

 

 

The objectives for this class are: 

• Starting a Point Cloud project 
• Import/Export point clouds 
• Defining a work zone and applying filters 
• Creating a TIN and contours in Point Cloud 
• Exporting grid points for TIN in CAD 
• Creating survey points and line work for field-to-finish 

 
Carlson Point Cloud Basic Overview 
Carlson’s Point Cloud Basic module provides the ability to go from field scan to finish plat from large 
data sets by allowing users to process millions of data points. Filter or decimate points, overlay raster 
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images, snap to edges and code the descriptions for automated field to finish processing of linework and 
symbols.  

 

Carlson Project Setup 
Begin by creating a new Carlson project. 

• Open Carlson by double-clicking the icon on your desktop. 
• In the Start Page, click New Drawing.  

 
 

• In the New Drawing Wizard dialog, keep Drawing Type set to DWG and Use a template drawing 
toggled on. 

 
 

• In the Template Drawings dialog, select carlson.dwt and click Finish. 
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• In the Starting Drawing Wizard dialog, click Set.  

 
 

• You will now create a new directory for the project. In the Drawing to Create dialog, click 
Browse and then create a new folder under the Carlson Projects directory named Point Cloud 
Basic Lesson (if you haven’t done so already).  

 
 

• In the File Name field, type Point Cloud Lesson and then click Save to return to the Drawing to 
Create dialog and Save again to return to the Wizard. It is not necessary to type the file 
extension. 

• Notice the Scale Settings, the project scale is used to control the symbol height and the plotted 
height/printed height of the text. This will set the project default and can be changed later if 
necessary. We will keep the default value of 20. 

o As a reminder, if the desired plotted text height is 0.08 inches, at a 1:20 scale this text 
will need to be 1.6 drawing units.  

• Set Projection set to State Plane 83 and the Zone to KY North. If you select None, you can 
change the projection settings later if necessary. 
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• The Startup Wizard Data Files dialog will open. 

 
 

• The Data Path allows you to set the location of the different project files if you want to 
distinguish them.  

• The CRD File or Carlson coordinate file is the external file that Carlson uses to store the point 
data, i.e., point numbers, northings, eastings, elevations and descriptions. Keep the default path 
and choose New to start a new file. CRD files can be used to import the survey data from the 
field crew using SurvCE/PC.  

• Keep Import Point From set to None. 
• Click Next to complete the Wizard. 

 

Creating a Point Cloud Project 
To provide the ability to work with the large amount of data associated with a point cloud, Carlson’s 
Point Cloud will manage the point cloud data through the Point Cloud Manager. You will find all the 
import, edit, point and line creation, triangulation and export tools in it.  

• From Settings menu, select Carlson Menus  then Point Clouds Menu.  

 
 

• From the Point Clouds menu, select Project Manager. The first time Point Clouds is launched, 
the Point Cloud Manager will open automatically.  
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• Click the New button. 

 
 

• Type Point Cloud Lesson as the file name, then click Save. 
• A new point cloud project tree will be displayed in the Project tab. 

 
 

Point Cloud Project Settings 
Before we get started, it is good to check the point cloud project settings. 
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• Click the Settings button. 

 
You can change the Units’ precision. 

 
 

• Naming Conventions, particularly the number of digits and suffixes used as you apply filters and 
add data. 

 
 

• And adjust the CAD Settings. I recommend not checking on the option to automatically draw 
points, lines and text in CAD as every time you add or edit, your work will be synchronized with 
the drawing slowing you down. Don’t worry, to draw in CAD only takes one click later. 
I do recommend turning on Use CAD’s CRD for PointCloud’s Coordinate Points as this will keep 
your Carlson project CRD file synchronized. 
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• Click Green check to close and save the changes. 

 

Import the Point Cloud Data 
The point cloud data that you will be processing may come from a terrestrial scan, publicly available 
LiDAR data and aerial photogrammetry data. It is important to know that when working from ground 
scans, Point Cloud can handle different scanner setups which will allow you to get a true 3D 
representation of the site. Once these ground scans are registered, they would have obtained a 
coordinate system and Point Cloud can be used to merge this data. For this lesson we will be using a 
point cloud obtained from an aerial survey using an unmanned aerial vehicle (UAV).  

• In the Project tab, right-click on Clouds. Then select Import, and LiDAR (.las/.laz) 

 
 

• Select the dense_point_cloud file provided in the compressed Point Cloud Basic Lesson.zip file. 
This will open the Change LAS Projection window. Note that the number of points that will be 
imported is listed by the file name.  
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• As our data comes from drone flight images that were processed in Carlson PhotoCapture, our 
data has all the necessary projection information, unit type and scale. For the purpose of our 
lesson, we won’t run either duplicated points or resampling which are decimation tools (i.e., 
filters). If your data was classified, an additional window will open prompting to select the 
classifications that you want to import giving you the option to import as Carlson Point Cloud 
Regions which can be used to turn on/off their visibility.  

• Click Green check.  
• Notice that the point cloud listed in the Project Manager displays the .las file name. You can 

rename and simplify. Right-click on the point cloud, then select Rename. Name it 01- Original 
Cloud. 
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• Lastly, you can check the point cloud properties at any time to get an idea of number of points, 
position ranges and whether it contains classifications. To do this, right-click on the point cloud 
name and select Properties. 

 
 

• Click Green check to close. 

Note: If you have a subscription to Carlson PhotoCapture, check the Getting Data from PhotoCapture appendix. 

Creating Point Cloud Scenes 
To begin the editing process, you will need to create “scenes” or views of the cloud. This will allow you 
to easily view when and where you are making changes. Also, as different filters are applied to decimate 
(remove points) from the point cloud, new point cloud data and scenes will be created automatically for 
you.  

• Right-click on our 01- Original Cloud and select View. Or, you can double-click on the name. 

 
 

• In the View Cloud window, we’ll keep the Action as Create new. The Color as Direct, which will 
keep the point colors as they were define by the aerial images. And, change the Orientation to 
Isometric.  
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• Click Green check to create the scene. Your screen will look somewhat like the image below. 

 

You can navigate the point cloud in the scene window in multiple ways. You can zoom in and out using 
the middle-button wheel in your mouse. Pressing the middle-button will behave as panning. And, left 
clicking will allow you to rotate the view just are when you work with Carlson’s 3D Viewer. In the toolbar 
you will find helpful shortcuts to set the view to top, front, perspective, etc. Take a moment to review 
these tools. 
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Define the Working Area 
As mentioned at the beginning, the goal for this lesson and for many projects is to obtain a 
representative surface model (TIN) of the project site from the point cloud data. With that in mind, it is a 
good practice to isolate or create a point cloud that is sub-set of the complete project. To this lesson, we 
are only concerned with the park and surrounding streets.  

• Start by changing the scene view to Top. 
• In the Project Manager, open the Action tab. In this tab, we will use the Perimeter tool under 

Selection Set. Using Perimeter Inside, we can draw a boundary to select all the points we are 
interested for our study. 

 
• Select an area similar to the image below that will include only the park and streets we are 

interested in. 

 
 

• To create the isolated, work area, from the Action tab, click the Cloud button in the Create 
section. 
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•  Name the resulting cloud 02- Working Area. 

 
 

• Now, to view the results, Close the current scene window. Notice the title is “Scene 01- Original 
Cloud”. 

• Then, from open the Project tab in the Project Manager and double-click on the “02- Working 
Area” cloud. This will create a new scene as discussed earlier. Your window should look similar 
to the image below. 

 
 

 

Clean the Point Cloud Data 
Although we isolated the work area in the previous step, a quick review of the new point cloud 
properties will reveal that we still have close to 2 million points left. And clearly there are still vehicles 
and other undesired point data in our data, i.e., noise. Therefore, we will start applying different filters 
to decimate or reduce the point cloud data. As stated earlier, which and how many filters you will want 
to apply to your project will be a decision you will want to make on a project-by-project basis.  
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Let’s start with the simplest Clean Cloud filters, remember though that you can apply the filters multiple 
times if needed.: 

Duplicated Points – this method searches por two or more points that are within the Distance 
Threshold and then will remove them. This method is typically fast and helps reduce much of the 
redundancy in the data. For example, data collected with a ground scanner will have more 
points than necessary right next to the scanner. 

Isolated Points – searches for points that have less than Minimum Neighbor Counts within the 
threshold and delete them. 

Redundant Points – this parametric method is more useful when needing to reduce the flat 
areas down to one point. It will create a user-defined box and check how the points inside of it 
fit the plane and/or have a color match.  

For this first cleaning lesson, we will apply the three described filter options to give you an opportunity 
to review the results. But, it is important to know that these three should not be applied simultaneously. 
We will start by removing duplicated and isolated points.  

• From the Project tab, right-click on “02- Working Area” and select Clean. 

 
 

• Make sure the name is set to 02- Working Area – Cleaned, this will help keep the project’s 
clouds listing sorted in the desired order. Keep Remove duplicated points checked, in 3D. And, 
Removed isolated points. 



 
 

Carlson Software | 33 East Second Street | Maysville, Kentucky USA | 606.564.5028 
www.carlsonsw.com 

 
 

• Click Green check to apply the filter. A new point cloud will be generated. 
• Close the current scene and open a new scene for the resulting cloud. Check the properties. 
• In the Project tab, click the Save button to save the current status of the project. Note that the 

Point Cloud program has an auto-save function but it is good practice to save after big changes. 

 
 

You will notice that the cloud data was reduce by a few more hundred thousand points. Now, you will 
apply the redundant points cleaning filter.  

• Right-click on the “02- Working Area – Cleaned” from previous step, and select Clean again.  
• Name the new cloud 02- Working Area – Cleaned by Redundant Points. 
• Uncheck Remove duplicated points and Remove isolated points. 
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• Check Remove redundant points and use the settings as shown below. 

 
 

• Click Green check to process. Close the current scene and create a new one as before. Check the 
resulting point cloud properties. You will notice that this last filter reduced the file to a few 
hundred thousand points. 

 
 

Resampling the Cloud Data 
Resampling is another method to decimate the point cloud data. There are two methods: 

Step – this method reduces the cloud to 1/Step it’s current size. It is fast but at the cost of being 
less intelligent. 

OC-Tree – analyzes the data by using user-defined bounding boxes to search for minimum and 
maximum numbers of points within the ranges and deleting points. This method may take a few 
minutes to complete depending on the amount of points in your point cloud data. 
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As you noticed from the last step when using the Clean filters, our data has been significantly reduced 
and therefore we won’t apply the resampling method.  

 

Applying Bare-Earth Filter 
If you navigated the “02- Working Area – Cleaned by Redundant Points” cloud, you noticed that we still 
have some vehicles and trees in the data. We can automate the removal of these data by applying the 
Bare-Earth filter. 

Bare Earth by Profile – this method works by drawing a 3D line away from the selected position 
and seeing if it slopes too sharply, removing any vertical segments and keeping any flat 
segments. 

Bare Earth by Grid – works by inspecting the cloud as a grid to find the lowest valid points in 
each grid cell and keeping only those points.  

As every project is different, you may want to apply one or the other filter. For our lesson, the Grid 
method is more appropriate. But, as an example, if your project is on a hillside, the Profile method may 
be best.  

• Right-click on the point cloud and select Bare Earth by Grid. 

 
 

• Name the new cloud 03- Working Area – Bare Earth. Set the Cell Size to 4, Pothole Depth to 0.5 
and Curb Height to 0.8.  
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• Click OK to apply the filter.  
• Close the current scene and create a new one for the resulting “03- Working Area – Bare Earth” 

cloud. If you check the properties, you will find that a few more tens of thousands of points 
were removed. The resulting cloud should be similar to the image below. 

 
 

 

Delete Points Manually 
Closer review of the data after applying the bare earth filter will reveal that there are some areas in the 
project that we can still further clean. For this lesson, we will accomplish this by using the cloud point 
selection and delete tool. As a reminder, you can re-run any of the filters. Note, that in some cases the 
current data may be sufficient for your project and no further actions needed.  

To illustrate this, we will clean up a small area in one of the planters that wasn’t cleaned up: 

• In the Scene window, change your view such that you can clearly see the targeted area. For 
example, the one below. 
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• In the Action tab, under Selection Set, click the Window button. 

 
 

• Use the window selection to select the points you want to delete. Note that you can adjust your 
view as necessary, whether zooming in/out, rotating, front view, etc. 

• With the correct points selected, click the Delete button in the Edit section. 

 
 

• Repeat as necessary and save when done.  

 

Other tools in the Selection Set area allow you to invert selection sets, use polylines (either draw one or 
use an existing one) and colors to find the targeted points.  

 

Create Surface Using Remaining Point Cloud Data 
With all the filters that we’ve applied, we reduced the original point cloud to a few hundred thousand 
points which can be used to create a surface model (TIN), contours, profiles and volume calculations 
directly in Point Cloud. As stated in the beginning, our intent is to obtain a representative surface model 
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(TIN) of a project site from a point cloud therefore we can do it now. It is important to know that this 
isn’t the only way as you may prefer to create the surface and contours in CAD – check the Virtual 
Surveying lesson after this.  

 

• From the Action tab, click the TIN button in the Create section. 

 
 

• Select Export to Carlson TIN, this will generate a .tin file that can be used by all the Carlson 
office products. In the Save file window,  name it Point Cloud Lesson.tin. 

 
 

• Click Green check to create the surface from the cloud points.  

If you want to view the contours, I recommend creating a new scene. 

• From the Action tab, click the Contours button in the Extract section. 
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• Choose the contour interval, include index contour and check erase existing contours in scene. 

 
 

• The contours will be drawn on the scene. Your screen will look similar to the image below.  
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Create Points and Lines for Field-to-Finish Processing 
Now, let’s explore a different method for obtaining the desired surface but this time we will leverage the 
point and line creation tools found in Point Cloud to create points with descriptors that can be 
processed in Carlson Survey using Field-to-Finish. Depending on your project scope and preferences, this 
may be the preferred way to get to our desired surface and contours. 

The following steps can be done from any of the scenes/views found in the Point Cloud Manager but for 
simplicity and explanation purposes we will use the original working area cloud and scene. We will 
create a group of points with description following the top of curb for one of the streets. 

• Close any scenes that you have open. 
• Now open Scene 02 – Working Area. This scene should have the isolate point cloud with dense 

data.  
• From the Action tab, click the Point button in the Create section. 

 
 

• Under Snap Mode, select Low Point. The Active List should be set to Coordinate Points. Set the 
desired starting Point Number.  

 
 

o If you have a customized or preferred Carlson field code table, click the Code button. 
Then click Pick FLD File to browse and select your custom field code table. Once 
selected, you will see all your codes listed and ready for selection. In this example, you 
can use the Carlson.fld file and select the EP code for edge of pavement.  
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o Notice the Field-to-Finish setting is set to Start line and there are both an End and Close 
buttons (same icons as those found in SurvCE/SurvPC). 

• In the scene viewer, place your cursor where you want to create the point and then continue 
selecting other places just as if you were in the field collecting data, i.e., virtual surveying. Your 
screen may look similar to the image below. 

 
 

• You will be creating the same codes/lines until you End the line or change codes (just as you 
would do in the field). To add arcs, toggle Start Curve (PC).  Use this to create the arc at the 
street intersection. 

 
 

• Continue as necessary.  
• Use other codes to place the manholes, light poles, etc. found in the area.  
• Once done click End Action. 
• Save the project. 
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What about lines without placing points?  

• From the Action tab, select Polyline. 

 
 

• Notice that the placement options are like points and several options to draw and edit the lines. 
Difference is that the software will not place points. 

 
 

• Click the End Action button to close. 
• Save the project. 
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Topo Points by Grid 
In the lesson above, you followed a virtual survey process to place specific points and generate linework. 
Now then, to create a group of general topo points Point Cloud has a Survey by Grid option that will 
automate this process. With that in mind, we spent the time to clean up the point cloud data, thus we’ll 
use the resulting cloud to obtain this final set of points. 

• Close the current scenes. 
• For the lesson, we will create a new scene from the “03- Working Area – Bare Earth” cloud, 

name it Scene 04- Survey by Grid. 
• From the Action tab, click the Point button n the Create section.  
• Click the Survey by Grid button in the Automation section (you may need to scroll down in the 

window). 

 
 

• Use X for point description, in the default Carlson field code table, this is the natural ground 
code. Change starting point number to desired value. Make sure that Elevation Method is set to 
Lowest. We don’t have either inclusion nor exclusion boundary polylines in this project.  
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• Click OK to place the points. This may take a few minutes depending on the selected area and 
grid dimensions. The results will be similar to the image below. 

 
 

• Click End Action. 
• Save the project. 

Notice how the current project now has Processed Data listed. 
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It is good to know that lines and points from the CAD drawing could have been imported as references. 
Also, if drawing linework, you can upload the layer names/settings from CAD into the Point Cloud 
Manager to keep everything categorized per your standards.  

 

Drawing the Points and Lines to CAD 
Now that we have points and linework, it is time to draw all these entities in CAD. If you used both 
points and lines, we can do this in two separate steps. First field-to-finish for the points and then draw 
polylines for remaining linework. 

• In the Project tab, right-click on Coordinate Points and select Field-to-Finish 

 
 

• This will bring up Carlson Survey’s Draw Field to Finish window. Make sure that you have the 
correct field code table selected. For our lesson, this would be the Carlson.fld code table.  
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• Click OK and the points and lines will be processed in CAD. 

 
 

• If you drew lines separately, right-click Polylines in the Current Project / Processed Data tree and 
then Draw. Or select a specific set of lines.  

Once in CAD, you can use the Carlson Survey/Civil tools to triangulate and contour the surface. 
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Appendix – Getting Files Directly from Carlson PhotoCapture 
If you have a subscription to Carlson PhotoCapture to process you the images from your drone projects, 
downloading the project data from the web service to your project folder can be simplified. 

• From the File menu, select Carlson PhotoCapture. 

 
  

• In the Carlson Customer Login window, input your PhotoCapture credentials and click Login. 

 
 

• The Select PhotoCapture Project window will display all the projects you have available on the 
web service. Select the project you will be working with and then click OK. 

 
 

• After a moment, the PhotoCapture Project Files window will open with a listing of all the 
PhotoCapture output files that can be downloaded. You will want to download the orthoimage, 
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dense point cloud data and project report. Highlight the files to download, check Simplify File 
Names and the click Download. 

 
 

• Once the downloads are complete, click Finish in the PhotoCapture Download Queue window. 

 
 

• A report window will open if you want to confirm and save the information regarding the 
downloaded project.  
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• The downloaded files will be found in the project folder. 
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